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Parallels® Client for Linux is an app that allows you to connect to Parallels Parallels RAS from a 
Linux computer and run remote applications and desktops. 
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Parallels RAS 18 release history 
The following table lists the Parallels RAS 18 release history. Parallels RAS documentation is 
updated for every release. This guide refers to the latest Parallels RAS 18 release from the table 
below. If you are using a newer Parallels RAS release or version, please download the current 
version of the guide from https://www.parallels.com/products/ras/resources/. 

Parallels RAS Version Release Date 

18.0 Initial release 12/14/2020 

18.0 Update 1 03/03/2021 

18.1 Initial release 07/14/2021 

18.2 Initial release 11/03/2021 

18.3 Initial release 12/21/2021 

18.3 Update 1 02/16/2022 
 

System Requirements 
Supported Linux distributions (x64 versions only): 

• Ubuntu 16.04 LTS, 18.04 LTS, 20.04 LTS 

• Debian 9 (Stretch), Debian 10 (Buster) 

• Fedora 33, 34 
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• CentOS 7, 8 

• Linux Mint 19, 20 

• ThinOS/ Dell Wyse Thin Clients. Note that ThinOS 9 and above are not supported. 
 

Installing Parallels Client for Linux 
Your system administrator will send you an invitation email with the instructions on how to install 
Parallels Client for Linux and configure a Parallels RAS connection in it. The invitation email will 
contain the following information and action links: 

• A message from your system administrator. 

• A link to download Parallels Client for Linux. 

• A link to automatically configure Parallels Client on your computer. 

• Parallels RAS connection properties. You can use this information to manually create a Parallels 
RAS connection. The automatic configuration via the link (see above) is the preferred and the 
easiest method, but you can use this information to create a connection manually if needed. 

To install Parallels Client for Linux using an invitation email: 

1 Make sure you are logged into your computer as a user with administrative privileges. 

2 In the invitation email, click the Linux thumbnail to download Parallels Client for Linux installer. 

3 Download the installer and store it locally. 

Installation Procedure — GUI 

Installation via GUI is only valid on DEB and RPM versions: 

• Install the package using the default package installer. 

Installation Procedures — CLI 

DEB Version 

To install Parallels Client, switch to the root user and type the following at the command prompt: 
dpkg -i parallelsclient.deb 

If the installation fails because of missing dependencies, try installing these dependencies using the 
following command: 
apt-get -f install 

Parallels Client for Linux binaries are now installed in the following directory: 
/opt/2X/Client/bin 

Run the following command to launch Parallels Client: 
/opt/2X/Client/bin/2XClient 
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You can also run the following commands to obtain a list of all usage parameters for a Parallels 
Client session: 
cd /opt/2X/Client/bin 
/appserverclient -? 

RPM Version 

To install Parallels Client, switch to the root user and type the following command: 
rpm –ivh 2XClient.i386.rpm 

Parallels Client binaries are now installed in the following directory: 
/opt/2X/Client/bin 

Run the following command to launch Parallels Client: 
/opt/2X/Client/bin/2XClient 

You can also run the following commands to obtain a list of all usage parameters for a Parallels 
Client session: 
cd /opt/2X/Client/bin 
/appserverclient -? 

.TAR.BZ2 Version 

To install Parallels Client, switch to the root user and then switch to the root directory: 
cd / 

To install, type the following command: 
tar jxvf 2XClient.tar.bz2 

Parallels Client binaries are now installed in the following directory: 
/opt/2X/Client/bin 

It is recommended that the post-install script is launched in order to register icons, mimetypes, URL 
schema, and databases configurations. This script is located under: /opt/2X/Client/scripts/install.sh 

Run the following command to launch Parallels Client: 
/opt/2X/Client/bin/2XClient 

You can also run the following commands to obtain a list of all usage parameters for a Parallels 
Client session: 
cd /opt/2X/Client/bin 
/appserverclient -? 

To unregister the components registered during installation, it is recommended to launch the 
uninstall script located under: /opt/2X/Client/scripts/uninstall.sh 
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The SSO (Single Sign On) Module Installation Procedures 

A separate package to install the SSO module is provided for each version of Linux: 

• RASClient-sso_x86_64.deb 

• RASClient-sso_x86_64.tar.bz2 

• RASClient-sso.x86_64.rpm 

Debian SSO packages can be installed and removed using standard installers. 

Tar SSO packages can be installed and uninstalled by running /opt/2X/Client/scripts/install_sso.sh 
or /opt/2X/Client/scripts/uninstall_sso.sh respectively. 

Rpm SSO packages need to be configured manually after the installation, as there is no tool 
available to configure the module correctly. For manual configurations refer to README.SSO that is 
being shipped inside the /opt/2X/Client/doc/ folder. 

Known issues and limitations 

In RPM environments (e.g. Fedora), where the pam-auth-update tool is not available, the 
configuration of the pam module needs to be done manually. There are instructions in the 
README.SSO file. 
 

Configuring Parallels Client for Linux 
Once Parallels Client for Linux is installed on your computer, you need to configure it, so you can 
connect to Parallels RAS. 

To configure Parallels Client: 

1 In the invitation email that you received from your system administrator, find the Configure 
section and click the Click Here to auto configure the downloaded client link and follow the 
instructions. 

2 Once the Parallels Client is configured, it will open and ask you to log into Parallels RAS. 

3 Select the Authentication type from the following:  

• Credentials. Select this option to connect to Parallels RAS by supplying your credentials, 
such as your domain user name and password. 

• Smart card. Select this option to connect to Parallels RAS using a smart card. 

• Single Sign-On. This option will be included in the list only if the Single Sign-On module is 
installed during Parallels Client installation. Select this option to use local system credentials 
to connect to the remote server  
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Note for Administrators: The allowed authentication type(s) must be specified in the RAS Console in 
Connection / Authentication. 

4 Depending on the authentication type selected, type your user name and password or insert a 
smart card into a reader. If using a smart card, enter a PIN when prompted. 

5 Click Connect.  

6 This step may, or may not, appear depending on whether the two-factor authentication using 
the Google Authenticator app is configured in Parallels RAS by the administrator. If Parallels 
RAS is configured to use Google Authenticator, you will need to take additional steps. First you 
need to install the Google Authenticator app on your mobile device. When you click Connect in 
Parallels Client, you'll see a dialog displaying a barcode (also known as QR code) and a secret 
key. Scan the code (or enter the secret key) into the Authenticator app. The app will generate a 
one time password. Click Next in Parallels Client and enter the one-time password in the OTP 
field. Click Connect. On every subsequent logon, you'll only have to enter the OTP. For step-
by-step instructions, see the Using Google Authenticator subsection below. Please note that 
other TOTPs are also supported (not only Google Authenticator), such as Microsoft 
Authenticator app. 

If the login is successful, the main Parallels Client window opens displaying the published resources 
that you can use. To open a resource, navigate the published folder tree and double-click a desired 
resource to open it. 

Using Google Authenticator 

Use the following instructions when you see the multi-factor authentication dialog during the login 
procedure. The dialog is displayed when your IT administrator configures two-factor authentication 
using  the Google Authenticator app. 

Important: To use Google Authenticator, the time on your computer must be synchronized with a global 
NTP time server, such as time.google.com. Otherwise, Google authentication will fail. 

To use Google Authenticator, you need to install the Authenticator app on your iOS or Android 
device. Simply visit Google Play or App Store and install the app. Once the Authenticator app is 
installed, you are ready to connect to Parallels RAS using two-factor authentication. 

To connect to Parallels RAS: 

1 Opens Parallels Client and log in using your credentials. 

2 The multi-factor authentication dialog opens displaying a barcode (also known as QR code) and 
a secret key. 

3 Open the Google Authenticator app on your mobile device:  

• If this is the first time you use it, tap Begin and then tap Scan a barcode. 

• If you already have another account in Google Authenticator, tap the plus-sign icon and 
choose Scan a barcode. 

4 Go back to your computer and scan the barcode displayed in the Parallels Client login dialog. 
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If scanning doesn't work for any reason, go back in the Authenticator app, choose Enter a 
provided key and then enter the account name and the key displayed in the Parallels Client 
login dialog. 

5 Tap Add account. This will create an account for your RAS connection and display a one time 
password. 

6 Go back to Parallels Client, click Next and enter the one-time password in the OTP field. 

On every subsequent logon, you only need to type your credentials (or nothing at all if the Save 
password options was selected) and enter a one-time password obtained from the Google 
Authenticator app (the app will continually generate a new password). Please note that your IT 
administrator has an ability to reset user accounts in Google Authenticator. If your account is reset, 
you'll need to repeat the registration procedure described above. 
 

Checking for Updates 
To check for the latest available version of Parallels Client for Linux: 

1 In the main Parallels Client for Linux window, click Tools > Options.  

2 In the Options dialog, click the General tab. 

3 Click the Check for updates now button to see if a newer version of Parallels Client for Linux is 
available.  

4 You can also select the Check for updates on startup option to check for Parallels Client 
updates every time you open it. 

The rest of the options are described in the Configuring Global Options section (p. 37). 

 



 

 

Read this chapter to learn how to use Parallels Client for Linux. 
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Adding a New Connection 
Parallels Client allows you to have more than one connection, so you could easily connect to 
different servers or using different connection properties, etc. 

To manually add a connection: 

1 From the main menu, click File > New Connection. 

2 Select the type of connection to create: 

• Parallels Remote Application Server allows you to use published applications, 
documents, or desktops. 
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Using Parallels Client for Linux 



12 
 

Using Parallels Client for Linux 
 

• Standard RDP allows you to connect to any remote computer that accepts standard 
Remote Desktop connections. 

 

3 On the next screen, enter the connection properties. 

 

When creating a Parallels RAS connection, your system administrator should give you the 
connection information that must be specified in this dialog. If you received an invitation email 
from your administrator, you can find this information at the bottom of the message. The 
information will look similar to the following: 

To manually configure the Parallels RAS Connection, use the 
following settings: 
 
Server: 192.168.1.10 
Port: 443 
Connection Mode: Gateway Mode 

When creating a Standard RDP connection, you need to know the IP address or hostname of 
the remote computer you want to connect to. 
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4 In the Server field, enter the Parallels RAS IP address or hostname (this should be the server 
where the RAS Secure Client Gateway resides). If creating a Standard RDP connection, specify 
the remote computer IP address or hostname. 

5 The Connection Mode drop-down list is enabled only when creating a Parallels RAS 
connection. Select one of the following options: 

• Gateway Mode. Parallels Client connects to the RAS Secure Client Gateway and the 
session connection is tunneled through the first available connection. This mode is ideal for 
servers that are only reachable via the gateway and do not require a high level of security. 

• Direct Mode. Parallels Client first connects to the RAS Secure Client Gateway for the best 
available terminal server and then connects directly to that server.  This is best used when 
the Parallels Client and the terminal server reside on the same network. 

• Gateway SSL Mode. Same as the gateway mode above, but uses encryption to secure the 
data. 

• Direct SSL Mode. Same as the direct mode above, but uses encryption to secure the data. 

6 In the Friendly name field, choose and type a friendly name for this connection. 

7 The Advanced settings button opens the Connection Properties dialog where you can 
specify additional connection properties. For more information, see Configuring a RAS 
Connection (p. 13) or Configuring an RDP Connection (p. 28). 

8 Click OK to create a connection. 
 

Configuring a RAS Connection 
To modify the properties of an existing Parallels RAS connection, right-click it in the main Parallels 
Client window and then click Connection Properties in the context menu. This will open the 
Connection Properties dialog. Properties are grouped in the dialog by functionality using tab 
pages. The following subsections describe each tab page in detail. 
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Connection 

The Connection tab page allows you to specify connection settings and logon information. 

 

Configuring the Primary Connection 

On the Connection tab page, you can define a primary connection and one or more secondary 
connections. 

The primary connection is what Parallels Client will use first to connect to the specified server. This 
should be the server where the primary RAS Secure Client Gateway is running.  

To specify the primary connection information: 

1 In the Primary Connection field, specify the server name or IP address. To connect to a 
specific RAS Theme, specify its name after the server name or IP address separated by a slash. 
For example, workspaceus.parallelsras.net/theme1. If not sure which Theme you should use, 
ask your system administrator. 
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2 In the Connection Mode drop-down list, select one of the following options: 

• Gateway Mode. Parallels Client connects to the RAS Secure Client Gateway and the 
session connection is tunneled through the first available connection. This mode is ideal for 
servers which are only reachable via the gateway and do not require a high level of security. 

• Gateway SSL Mode. Same as the gateway mode above, but uses encryption to secure the 
data. 

• Direct Mode. Parallels Client first connects to the RAS Secure Client Gateway for the best 
available terminal server and then connects directly to that particular server.  This is best 
used when the Parallels Client and the terminal server are on the same network. 

• Direct SSL Mode. Same as the direct mode above, but uses encryption to secure the data. 

3 In the Port field, specify the port on which the gateway listens for incoming connections. If the 
default value (80) has been modified on the server side, you have to replace the default value 
here as well. Ask your system administrator about the port number if you are having a problem 
connecting to the server. 

4 In the Friendly Name field, choose and type a name of your choice, so you could easily identify 
the server in Parallels Client later. 

Configuring a Secondary Connection 

If the Parallels RAS farm that you are connecting to has more than one RAS Secure Client 
Gateway, you can define a secondary connection, which will be used as a backup connection in 
case the primary gateway connection fails. 

To add a secondary connection: 

1 Click the Secondary Connections button. 

2 In the Secondary Connections dialog, click the Add button and specify a server name or IP 
address. This should be a server hosting a secondary RAS Secure Client Gateway (the primary 
gateway is used by the primary connection). 

3 Select the connection mode and modify the port number if necessary. Click OK and then click 
OK again to return to the Connection Properties dialog. 

Configuring the Logon Information 

In the Logon section, specify the following properties: 

1 Select the Auto Logon option to enable Parallels Client to connect automatically (using this 
connection) on startup. 

2 In the Authentication type drop-down list, select the desired method of authentication: 
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• Credentials. Select this option and then enter the username, password, and domain 
information. You will be authenticated on the remote server using the specified credentials. 
Please note that if the password specified in the connection properties has expired or will 
expire soon, you will see a corresponding message on the screen when trying to connect to 
Parallels RAS. If the password has expired, you'll be asked to change it. If the password will 
expire soon, you will be offered to change it now or later. Follow the onscreen instructions 
and change your password. 

• Smart Card. Select this option to authenticate using a smart card. When connecting to the 
remote server, insert a smart card into the card reader and then enter a PIN when 
prompted. 

• Single Sign-On. This option will be included in the list only if the Single Sign-On module is 
installed during Parallels Client installation. Select this option to use local system credentials 
to connect to the remote server. 

Note for Administrators: The allowed authentication type(s) must be specified in the RAS Console in 
Connection / Authentication. 
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Display 

The Display tab page allows you to configure display options. 

 

• Color Depth. Specify the desired color depth. 

• Size. This option is available for standard RDP connections only. 

• Graphics Acceleration. Choose the graphics encoding. The more advanced the acceleration, 
the better will be the quality of the graphics. Please keep in mind that higher quality 
accelerations require more processing power and faster network. 

Note: The acceleration setting does not affect connections with color depth less than 32 bit. 

• None. No graphics acceleration. 

• Basic. Basic acceleration. 

• RemoteFX. More powerful graphics acceleration using the RemoteFX codec. 
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• RemoteFX Adaptive. Best graphics acceleration using RemoteFX Adaptive and H.264 
codecs. 

Note: If you select RemoteFX or RemoteFX Adaptive, the color depth is forced to 32 bit. 

• Published Applications - Use primary monitor only. If selected, only the primary monitor 
connected to your Mac will be used to display remote applications. 

• Desktop Options - Span desktops across all monitors. If selected, remote desktops will be 
spanned across all connected monitors. 

 

Printing 

The Printing tab page allows you to configure printing options. 
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In the Technology drop-down list, select the technology to use when redirecting printers to a 
remote computer: 

• None. No printer redirection will be configured. 

• RAS Universal Printing technology. Select this option to use RAS Universal 
Printing technology. 

• Microsoft Basic Printing Redirection technology. Select this option to use Microsoft Basic 
printing technology. 

• RAS Universal Printing and Microsoft Basic redirection technologies. Select this option to 
use both Parallels RAS and Microsoft technologies. 

RAS Universal Printing Technology 

If you selected RAS Universal Printing technology, you need to select printers to redirect in the 
Redirect Printers drop-down list:  

• All. All printers on the client side will be redirected. 

• Default only. Only the Windows default printer will be redirected.  

• Specific only. Select the printers to redirect in the provided list. The list becomes enabled for 
selection only if you select this option. 

Microsoft Basic Printing Redirection Technology 

If you selected Microsoft Basic Printing Redirection technology, you can modify printer 
properties by selecting a printer in the list and then clicking the Edit button. In the dialog that 
opens, specify a desired printer manufacturer and model number. 

Default printer settings 

To configure default printer settings, click the Change Default Printer settings button. 

The default printer list shows the available printers that are ready to be redirected by the client to 
the remote computer. The list also includes the printing technology that the available printers will 
use. The technology reflects the setting selected, as described in the Technology section (above). 
For example, if the technology was set to RAS Universal Printing technology, only the printers 
using RAS Universal Printing will be listed. 

To disable the default printer, select <none>. To redirect the default local printer on the client side 
to the remote computer, select <defaultlocalprinter>. When <custom> is selected, you can 
specify a custom printer which might be installed on the remote computer. The first printer that 
matches the printer name inserted in the custom text box, will be set as the default printer on the 
remote computer. 
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Select Match exact printer name to match the name exactly as inserted in the custom text box. 
Please note that the remote printer name may be different than the original printer name. Also note 
that local printers may not be redirected due to server settings or policies. 

You can specify the time a printer will be forced as default. If the default printer is changed during 
this time after the connection is established, the printer is reset as default. 

Select the Update the remote default printer if the local default printer is changed option to 
change the remote default printer automatically when the local default printer is changed. Please 
note that the new printer must have been previously redirected. 
 

Local Resources 

Use the Local Resources tab page to configure how local resources are handled by the remote 
desktop used in a remote session. 
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Remote Audio and Recording 

Use the Remote audio playback drop-down list to select one of the following remote audio 
playback options: 

• Bring to this computer. Audio from the remote computer will play on your local computer. 

• Do not play. Audio from the remote computer will not play on your local computer and will be 
muted on the remote computer as well. 

• Leave at remote computer. Audio will not play on your local computer but will play normally 
on the remote computer. 

Use the Remote audio recording drop-down box to select one of the following: 

• Record from this computer. Audio from this computer will be recorded using a remote 
application. 

• Do not record. Do not recored audio. 

Keyboard 

Select how you want to apply key combinations (e.g. Alt+Tab) that you press on the keyboard: 

• On the local computer. Key combinations will be applied to Windows running on the local 
computer. 

• On the remote computer. Key combinations will be applied to Windows running on the 
remote computer. 

• In full screen mode only. Key combinations will be applied to the remote computer only when 
in the full-screen mode. 

Local Devices and Resources 

Choose local disk drives, devices, and other resources that you want to redirect to a remote 
computer. Redirecting a resource makes it available for use in a remote session. For example, a 
redirected local disk drive will be available in a remote application, so you can read from and write 
to it. 

The following options are available: 

• Clipboard. Select this option to enable the clipboard in a remote session. Click the Configure 
button and choose clipboard redirection from one of the following: Bidirectional (allows to 
copy in both directions), Server to client only, Client to server only. 

• Disk drives. Select this option and then click Configure Drives. See the Configure Drives 
subsection below for details. 



22 
 

Using Parallels Client for Linux 
 

• Devices. Select this option and then click Configure Devices. Devices that are currently 
connected to your local computer will appear in the list. This includes supported Plug and Play 
devices, media players based on the Media Transfer Protocol (MTP), and digital cameras based 
on the Picture Transfer Protocol (PTP). If a device is connected to your computer, but does not 
appear in the list, it means it is not a supported Plug and Play device. Please note that disk 
drives and smart cards are excluded from this list (you redirect them using dedicated Disk 
drives and Smart cards options). The Show previously connected devices option displays 
devices that are not currently connected but were connected previously. 

Note: Please note device redirection is an experimental feature in Parallels Client for Linux and as such 
may have certain issues. Depending on a specific PTP/MTP device used, some operations can make 
the device stop responding to PTP/MTP requests. For example, if you start a copy operation to or from 
a device and then cancel it, the device may stop responding to all other requests. As a workaround, if 
you experience such an issue with your device, disconnect it from your Linux computer and then 
reconnect it. 

• Printers. Select this option to redirect printers. 

• Serial ports. Select this option to redirect serial ports. 

• Smart cards. Select this option to redirect smart cards. 

Configure Drives 

The Configure Drives button opens a dialog where you can map local Linux directories as disk 
drives and then use them in remote applications during a remote session. 

To map a directory, click the Add button and specify the following: 

• Share Point: Type the drive name as you want it to appear during a remote session (e.g. sd2). 
Please note that share names must be unique, use Latin characters only, and cannot be longer 
than seven characters. 

• Mount Point: Type a local Linux directory you would like to map (e.g. /home). 

Click OK to save the new drive information. The new drive will appear in the Configure Drives 
dialog. To edit an existing drive, click Edit. To delete a drive, click Delete. 

You can enable or disable disk drives by selecting or clearing a corresponding checkbox. To enable 
all drive, select the Use all disk drives available option. 
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Experience 

The Experience tab page allows you to tweak the connection speed to optimize the performance 
of the connection with the remote server. 

 

In the drop-down list, select your connection speed:  

• If not sure, select the Detect connection quality automatically option. Please note that if you 
select this option, all other options will be disabled and will be configured automatically based 
on the actual connection speed when Parallels Client is connected to Parallels RAS. 

• If you select a specific speed (e.g. LAN 10 Mbps or higher), select the desired user experience 
options. If you are connecting to a remote computer on a local network that runs at 100 Mbps 
or higher, it is usually safe to have all of the experience options turned on. Otherwise, select 
only the options that you require. 
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Network 

Use the Network tab page to configure a proxy server if you use one to connect to the remote 
computer. 

 

To configure a proxy server, select the Use proxy server option and then select the protocol from 
the following list: 

• SOCKS4. Enable this option to transparently use the service of a network firewall. 

• SOCKS4A. Enable this option to allow a client that cannot connect to resolve the destination 
host’s name to specify it. 

• SOCKS5. Enable this option to be able to connect using authentication. 

• HTTP 1.1. Enable this option to connect using the standard HTTP 1.1 protocol connections. 

Specify the proxy host domain name or IP address and the port number. 
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For SOCKS5 and HTTP 1.1 protocols, select Proxy requires authentication and enter user 
credentials. 
 

Authentication 

Use the Authentication tab page to specify what happens if server authentication fails. 

 

In the If authentication fails drop-down list, select one of the following options: 

• Connect. The user can ignore the certificate of the server and still connect. 

• Warn. The user is alerted about the certificate and still has the ability to choose whether to 
connect or not. 

• Do not connect. The user is not allowed to connect. 
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Advanced Settings 

The Advanced Settings tab page allows you to customize the default behavior or Parallels Client.  

 

You can specify the following properties: 

• Create shortcuts configured on server. For each published application, the administrator can 
configure shortcuts that can be created on the client's desktop and the Start menu. Select this 
option to create the shortcuts, or clear the option if you don't want to create them. 

• Redirect URLs to this computer. Enable this option to use the local web browser when 
opening 'http:" links. 

• Redirect Mail to this computer. Enable this option to use the local mail client when opening 
‘mailto:’ links. 

• Enable Compression. Enables compression to have a more efficient connection. 

• Connect to console. This option is disabled for Parallels RAS connections. 
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• Use Pre Windows 2000 login format. If this option is selected, it allows you to use legacy 
(pre-Windows 2000) login format. 

• Network Level Authentication. Check this option to enable network level authentication, 
which will require the client to authenticate before connecting to the server. 

The Override computer name field specifies the name that your computer will use during a remote 
desktop session. If set, this will override the default computer name. Any filtering set by the 
administrator on the server side will make use of this name. 

Connection advanced settings 

The Connection advanced settings button opens a dialog where you can configure connection 
timeout and reconnection settings. 

 

In the Connection settings section, specify the following: 
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• Connection timeout: The amount of time during which the client will try to connect to Parallels 
RAS until the connection is aborted. While the connection is being established, the connection 
banner will be shown. 

• Show connection banner if connection is not established within: Specifies the time period 
in seconds after which the connection banner will be displayed. 

• Show desktop if published application does not start within: If a published application is 
not launched within the time period specified in this field, the server’s desktop will be loaded. 
This is helpful if an error occurs on the server side while launching an application. By loading the 
server’s desktop, the user will be able to see the error message. 

• Reconnect if connection is dropped: Specifies the maximum number of retries if connection 
is dropped. 

• Show connection banner if reconnection is not established within: Specifies the time 
period in seconds after which the connection banner will be displayed. 

In the Reconnection section, specify the following: 

• Reconnect if connection is dropped: Select this option and set the number of Connection 
Retries. If a connection is dropped, Parallels Client will automatically try to reconnect. 

• Show connection banner if reconnection is not established within: If reconnection 
attempts fail after the time period specified here, the connection banner will be shown to the 
user. 

 

Configuring an RDP Connection 
To modify the properties of an existing standard RDP connection, right-click it in the main Parallels 
Client window and then click Connection Properties in the context menu. This will open the 
Connection Properties dialog. Properties are grouped in the dialog by functionality using tab 
pages. The following subsections describe each tab page in detail. 
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Connection 

The Connection tab page allows you to specify connection settings and logon information. 

 

In the Connection Settings section, specify the following properties: 

1 In the Primary Connection field, specify the remote computer hostname or IP address.  

2 The Port field contains the TCP port 3389 by default, which is the standard port for RDP 
connections. You can modify it if the port number was changed on the remote computer. 

3 In the Friendly Name field, choose and type a name of your choice, so you could easily identify 
the server in Parallels Client later. 

In the Logon section, specify the following properties: 

1 Select the Auto Logon option to enable Parallels Client to connect automatically (using this 
connection) on startup. 
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2 In the Authentication type drop-down list, select the desired method of authentication: 

• Credentials. Select this option and then enter the username, password, and domain 
information. You will be authenticated on the remote server using the specified credentials. 
Please note that if the password specified in the connection properties has expired or will 
expire soon, you will see a corresponding message on the screen when trying to connect to 
Parallels RAS. If the password has expired, you'll be asked to change it. If the password will 
expire soon, you will be offered to change it now or later. Simply follow the instructions and 
change (or postpone if you wish) your password. 

• Smart Card. Select this option to authenticate using a smart card. When connecting to the 
remote server, insert a smart card into the card reader and then enter a PIN when 
prompted. 

• Single Sign-On. This option will be included in the list only if the Single Sign-On module is 
installed during Parallels Client installation. Select this option to use local system credentials 
to connect to the remote server. 

Note for Administrators: The allowed authentication type(s) must be specified in the RAS Console in 
Connection / Authentication. 
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Display 

The Display tab page allows you to configure display options. 

 

• Color Depth. Choose the color quality. 

• Size. Choose the size of a remote desktop as it will appear on your screen. 

• Graphics Acceleration. Choose the graphics acceleration type. The more advanced the 
acceleration, the better will be the quality of the graphics. Please keep in mind that higher 
quality accelerations require more processing power and faster network. 

Note: The acceleration setting does not affect connections with color depth less than 32 bit. 

• None. No graphics acceleration. 

• Basic. Basic acceleration. 

• RemoteFX. More powerful graphics acceleration using the RemoteFX codec. 
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• RemoteFX Adaptive. Best graphics acceleration using RemoteFX Adaptive and H.264 
codecs. 

Note: If you select RemoteFX or RemoteFX Adaptive, the color depth is forced to 32 bit. 

• Use all monitors for Desktop session (if applicable). If you have more than one monitor 
connected to a remote computer, the RDP session will display both of them. The screen size 
must be set to Full Screen. The Span desktop across all monitors option must be disabled. 

• Published Applications - Use primary monitor only. Not used (disabled for RDP 
connections) 

• Desktop Options - Span desktops across all monitors. If selected, a remote desktop will be 
spanned across all connected monitors. 

 

Local Resources 

Use the Local Resources tab page to configure how local resources are used in a remote session. 
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Remote Audio and Recording 

Use the Remote audio playback drop-down list to select one of the following remote audio 
playback options: 

• Bring to this computer. Audio from the remote computer will play on your local computer. 

• Do not play. Audio from the remote computer will not play on your local computer and will be 
muted on the remote computer as well. 

• Leave at remote computer. Audio will not play on your local computer but will play normally 
on the remote computer. 

Use the Remote audio recording drop-down box to select one of the following: 

• Record from this computer. Audio from this computer will be recorded using a remote 
application. 

• Do not record. Do not recored audio. 

Keyboard 

Select how you want to apply key combinations (e.g. Alt+Tab) that you press on the keyboard: 

• On the local computer. Key combinations will be applied to Windows running on the local 
computer. 

• On the remote computer. Key combinations will be applied to Windows running on the 
remote computer. 

• In full screen mode only. Key combinations will be applied to the remote computer only when 
in the full-screen mode. 

Local Devices and Resources 

Choose local disk drives, devices, and other resources that you want to redirect to a remote 
computer. Redirecting a resource makes it available for use in a remote session. For example, a 
redirected local disk drive will be available in a remote application, so you can read from and write 
to it. 

The following options are available: 

• Clipboard. Select this option to enable the local clipboard in a remote session. 

• Disk drives. Select this option and then click Configure Drives. See the Configure Drives 
subsection below for details. 
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• Devices. Select this option and then click Configure Devices. Devices that are currently 
connected to your local computer will appear in the list. This includes supported Plug and Play 
devices, media players based on the Media Transfer Protocol (MTP), and digital cameras based 
on the Picture Transfer Protocol (PTP). If a device is connected to your computer but does not 
appear in the list, it means it is not a supported Plug and Play device. Please note that disk 
drives, printers, and smart cards are excluded from this list (you redirect them using dedicated 
Disk drives, Printers, and Smart cards options). The Show previously connected devices 
option displays devices that are not currently connected but were connected previously. 

Note: Please note that device redirection is an experimental feature in Parallels Client for Linux and as 
such may have certain issues. Depending on a specific PTP/MTP device used, some operations can 
make the device stop responding to PTP/MTP requests. For example, if you start a copy operation to or 
from a device and then cancel it, the device may stop responding to all other requests. As a 
workaround, if you experience such an issue with your device, disconnect it from your Linux computer 
and then reconnect it. 

• Printers. Select this option to redirect printers. 

• Serial ports. Select this option to redirect serial ports. 

• Smart cards. Select this option to redirect smart cards. 

Configure Drives 

The Configure Drives button opens a dialog where you can map local Linux directories as disk 
drives and then use them during a remote session. 

To map a directory, click the Add button and specify the following: 

• Share Point: Type the drive name as you want it to appear during a remote session (e.g. sd2). 
Please note that share names must be unique, use Latin characters only, and cannot be longer 
than seven characters. 

• Mount Point: Type a local Linux directory you would like to map (e.g. /home). 

Click OK to save the new drive information. The new drive will appear in the Configure Drives 
dialog. To edit an existing drive, click Edit. To delete a drive, click Delete. 

You can enable or disable disk drives by selecting or clearing a corresponding checkbox. To enable 
all drive, select the Use all disk drives available option. 
 

Programs 

The Programs tab page allows you to specify a program that will be started automatically on the 
remote computer when you establish a connection with it. Select the Start the following program 
on connection option and then specify the Program path and file name and Start in the 
following folder options. 
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Experience 

The Experience tab page allows you to tweak the connection speed to optimize the performance 
of the connection with the remote server. 

In the drop-down list, select your connection speed:  

• If not sure, select the Detect connection quality automatically option. Please note that if you 
select this option, all other options will be disabled and will be configured automatically based 
on the actual connection speed when Parallels Client is connected to Parallels RAS. 

• If you select a specific speed (e.g. LAN 10 Mbps or higher), select the desired user experience 
options. If you are connecting to a remote computer on a local network that runs at 100 Mbps 
or higher, it is usually safe to have all of the experience options turned on. Otherwise, select 
only the options that you require. 

 

Network 

Use the Network tab page to configure a proxy server if you have to use one to connect to the 
remote computer. 

To configure a proxy server, select the Use proxy server option and then select the protocol from 
the following list: 

• SOCKS4. Enable this option to transparently use the service of a network firewall. 

• SOCKS4A. Enable this option to allow a client that cannot connect to resolve the destination 
host’s name to specify it. 

• SOCKS5. Enable this option to be able to connect using authentication. 

• HTTP 1.1. Enable this option to connect using the standard HTTP 1.1 protocol connections. 

Specify the proxy host domain name or IP address and the port number. 

For SOCKS5 and HTTP 1.1 protocols, select Proxy requires authentication and enter user 
credentials. 
 

Authentication 

Use the Authentication tab page to specify what happens if server authentication fails. 

In the If authentication fails drop-down list, select one of the following options: 

• Connect. The user can ignore the certificate of the server and still connect. 

• Warn. The user is alerted about the certificate and still has the ability to choose whether to 
connect or not. 

• Do not connect. The user is not allowed to connect. 
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Advanced Settings 

The Advanced Settings tab page allows you to customize the default behavior or Parallels Client. 
You can specify the following properties: 

• Create shortcuts configured on server. For each published application, the administrator can 
configure shortcuts that can be created on the client's desktop and the Start menu. Select this 
option to create the shortcuts, or clear the option if you don't want to create them. 

• Redirect URLs to this computer. Enable this option to use the local web browser when 
opening 'http:" links. 

• Redirect Mail to this computer. Enable this option to use the local mail client when opening 
‘mailto:’ links. 

• Enable Compression. Enables compression to have a more efficient connection. 

• Connect to console. This option is used for administration of a Remote Desktop Session Host 
server. It acts as if a standard Remote Desktop connection is initiated from the command line 
with the /admin option. 

• Use Pre Windows 2000 login format. If this option is selected, it allows you to use legacy 
(pre-Windows 2000) login format. 

• Network Level Authentication. Check this option to enable network level authentication, 
which will require the client to authenticate before connecting to the server. 

The Override computer name field specifies the name that your computer will use during a remote 
desktop session. If set, this will override the default computer name. Any filtering set by the 
administrator on the server side will make use of this name.  

Connection advanced settings 

The Connection advanced settings button opens a dialog where you can configure connection 
timeout and reconnection settings. 

In the Connection settings section, specify the following: 

• Connection timeout: The amount of time during which the client will try to connect to Parallels 
RAS until the connection is aborted. While the connection is being established, the connection 
banner will be shown. 

• Show connection banner if connection is not established within: Specifies the time period 
in seconds after which the connection banner will be displayed. 

• Show desktop if published application does not start within: If a published application is 
not launched within the time period specified in this field, the server’s desktop will be loaded. 
This is helpful if an error occurs on the server side while launching an application. By loading the 
server’s desktop, the user will be able to see the error message. 
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In the Reconnection section, specify the following: 

• Reconnect if connection is dropped: Select this option and set the number of Connection 
Retries. If a connection is dropped, Parallels Client will automatically try to reconnect. 

• Show connection banner if reconnection is not established within: If reconnection 
attempts fail after the time period specified here, the connection banner will be shown to the 
user. 

 

Configuring Global Options 
To configure Parallels Client for Linux global options, click Tools > Options on the main toolbar. 

 

Advanced Settings 

The Advanced Settings tab page allows you to configure advanced options: 

• Language. Allows you to select the graphical user interface language. 

• Always on top. With this option enabled, other applications will no longer mask the launcher. 
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• Do not warn if server certificate is not verified. When connected over SSL, and the 
certificate is not verified, a warning message will be displayed. You can disable this warning 
message by enabling this option. 

• Show folders page. Enabling this option will show the available folders while showing the 
hierarchy of the application groups as configured on the server. 

• Swap mouse buttons. Swap mouse left and right buttons. 

• Minimize to tray on close or escape. Enable this feature to place the Parallels Client into the 
System Tray when you click on the Close button or hit escape. 

Keyboard Layout 

The Keyboard Layout tab page allows you to select a keyboard layout to use in the graphical user 
interface. Select System Default to use the default layout or select User defined and then select a 
keyboard from the list. 

General 

 

The General tab page allows you to configure general options: 
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• Logging. The Enable extended logging option enables or disables logging. Click the View 
Log button to view the log. Click the Clear Log File button to remove the information from the 
file. A log file contains information about standard Parallels Client actions, including establishing 
a connection, connection retries, starting of applications, and some others. 

• Check for updates on startup. This option is available only with administrative rights. If this 
option is selected, Parallels Client will check for available Parallels Client updates on startup. 
You can also click the Check for updates now button to check for updates at any time. 

• Enable FIPS 140-2 encryption. Select this option if your IT administrator instructed you to do 
so. If the option is selected, Parallels Client will use FIPS 140-2 encryption when connecting to 
Parallels RAS. If the Gateway through which Parallels Client connects requires FIPS, this option 
will be enabled automatically. If the encryption is allowed (but not required), you can select or 
clear the option, depending on your organization's policy. 

 

Using a RAS Connection 

Connecting to Parallels RAS 

To connect to Parallels RAS, double-click a connection in the Connections list (or right-click a 
connection and choose Connect). Please note that if the password specified in the connection 
properties has expired or will expire soon, you will see a corresponding message on the screen. If 
the password has expired, you'll be asked to change it. If the password will expire soon, you will be 
offered to change it now or later. Simply follow the instructions and change (or postpone if you 
wish) your password. 

You can have multiple active connections at the same time. To switch between active connections, 
click a connection in the left or the right pane. 

Right-click an active connection to perform the following actions: 

• Connect. This menu item is disabled for an active connection. 

• Refresh. Use this option to refresh the session and the the published resources view in the 
right pane. If there were changes on the Parallels RAS side, they will be reflected in the Parallels 
Client. 

• Connection Properties. Display the connection properties dialog where you can view (but not 
modify) the connection properties. To modify the connection properties, you must disconnect it 
first. 

• Change Domain Password. Allows you to change the current user's domain password. 
Displays the Parallels Client Logon dialog where you need to specify the existing password; 
then displays the Change Domain Password dialog allowing you to specify a new password. 
The password must meet the requirements set by your system administrator. The requirements 
are displayed in the dialog, and the password that you enter is validated against these 
requirements. To proceed with changing your password, all of the requirements must be met. 
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• Create Shortcuts for All Visible Applications. Creates shortcuts on the local desktop for all 
applications that are displayed in the published resources pane in the main Parallels Client 
window. 

• Delete Shortcuts from Desktop. Deletes shortcuts from the local desktop that were previously 
created by clicking the Create Shortcuts for all visible Applications menu item. 

• Disconnect. Disconnects the selected connection. 

• Log Off. Logs off Parallels Client from the session. 

• Delete. Deletes a connection. A confirmation dialog is displayed before the connection is 
deleted. 

Launching Published Resources 

After you connect to Parallels RAS, the Connections pane is populated with published folders. 
When you select a folder in the left pane, the resources that it contains are displayed in the right 
pane. If your administrator hasn't published any folders, then the available resources are displayed 
in the right pane when you select the connection itself. 

To launch a resource, double-click it in the right pane. The resource will open on your Linux 
desktop. You can also open a resource by selecting it in the right pane and then clicking 
Applications > Open in the main menu. Please note that there could be a slight delay before the 
application opens. If during this delay you double-click the resource again, Parallels Client will 
ignore it (i.e. the application will not be launched twice). 

Please note that the IT administrator may have some of the resources in maintenance. These 
resources will still be listed in Parallels Client but will be grayed out. If you try to open such a 
resource, you will see a message explaining why you cannot open it. The message can be 
customized by your IT administrator. 
 

Using an RDP Connection 
To connect to a remote computer, double-click an RDP connection (or right-click > Connect). 
Please note that if the password specified in the connection properties has expired or will expire 
soon, you will see a corresponding message on the screen. If the password has expired, you'll be 
asked to change it. If the password will expire soon, you will be offered to change it now or later. 
Simply follow the instructions and change (or postpone if you wish) your password. 

You can have multiple active connections at the same time (both standard RDP and RAS). To 
switch between active connections in Parallels Client, click a connection in the left pane or click the 
corresponding tab page in the right pane. 
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Right-click an active RDP connection to perform the following actions: 

• Connect. This menu item is disabled for an active connection. 

• Connection Properties. Display the connection properties dialog where you can view (but not 
modify) the connection properties. To modify the connection properties, you must disconnect it 
first. 

• Create Shortcut. Creates a shortcut for this connection on the local desktop.  

• Delete Shortcut from Desktop. Deletes the shortcut from the local desktop that was 
previously created by clicking the Create Shortcut menu item. 

• Disconnect. Disconnects the connection. 

• Delete. Deletes a connection. A confirmation dialog is displayed before the connection is 
deleted. 

 

Exporting and Importing Parallels Client Settings 
You can export current Parallels Client settings to a file to have a backup or to import the settings 
into Parallels Client installed on a different computer. The following settings are exported: 

• All existing connections including all individual connection properties. 

• Parallels Client preferences (global options). 

To export the current Parallels Client settings to a file, click File on the main toolbar and then click 
Export Settings. In the dialog that opens, specify a file name and destination folder. Click Save to 
export the settings. The file is saved with the ".2xc" extension. 

To import the settings, click File > Import Settings. In the dialog that opens, select the ".2xc" file 
and click Open. Please note that the imported settings override the current Parallels Client settings. 
 

Parallels Client Network Configuration File 
Parallels Client for Linux network settings can be specified using the configuration file, which can be 
found at the following location: 

~/.config/2X/Client/parallelssettings 

The settings are user specific. If a Linux machine is used by multiple users, each user needs to 
modify his/her own file. 
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Format 

The settings can be specified using the following format: 

[SETTING]=[VALUE] 

Example: 

KA_ENABLE=0 
 

Parameters 

This section describes parameters that can be used in the parallelssettings configuration 
file. 
 

KA_ENABLE 

Enable or disable the network keep-alive option. Sends network probes to detect if the network 
connection is alive. 

Value: 1 (Enabled) or 0 (Disabled) 

Default: 1 (Enabled) 

Example: 

Disable network probing: 

KA_ENABLE=0 
 

KA_MAXIDLE 

Specifies the idle time before the keep-alive network probing is initiated. Depends on the 
KA_ENABLE option being enabled. 

Value: Time in seconds. 

Default: 5 seconds 

Example: 

Set the idle time to 10 seconds: 

KA_MAXIDLE=10 
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KA_COUNT 

Specifies the number of keep-alive probes to send before closing the connection. Depends on the 
KA_ENABLE option being enabled. 

Value: An integer greater than 0. 

Default: 3 

Example: 

Set the number of probes to 6: 

KA_COUNT=6 
 

KA_INTERVAL 

Specifies the idle time between sending keep-alive network probes. Depends on the KA_ENABLE 
option being enabled. 

Value: Time in seconds. 

Default: 2 seconds 

Example: 

Set the idle time to 4 seconds: 

KA_INTERVAL=4 
 

USER_TIMEOUT 

Specifies the time period during which the transmitted data may remain unacknowledged before 
the connection is closed. This option is only supported on Linux kernel v2.6.37 and later. 

Value: Time in milliseconds 

Default: 9000 milliseconds (9 seconds) 

Example: 

Set the time period to 10 seconds. 

USER_TIMEOUT=10000 
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Parallels Client Command Line Interface 

Usage 

/opt/2X/Client/bin/appserverclient -s Server -u User [options] 
 

General Options 

General options: 

-m: operating mode 

2G for Parallels RAS gateway access client(default) 

2D for Parallels  RAS direct access client 

AL for Parallels RAS application list 

MS for Microsoft Terminal Server client 

MF for Microsoft Terminal Server fullscreen client 

MX for Microsoft Terminal Server fullscreen client, that spans over all monitors 

-s: server[:port] (default port is 80 for 2G and 2D modes and 3389 for MS and MF modes) 

-s: ssl://server[:port] secure access client (TLS/SSL) 

-b: altserver[:port] (default port is 80 for 2G and 2D modes and 3389 for MS and MF modes) 

-u: user name. It can include domain: -u user@host.domain or -u user@ntdomain 

-p: password. 

-d: domain. 

-a: application to start. 

-f: working folder. 

-i: 2xa shortcut file. 

2xa shortcut files available through Parallels RAS web interface, and include published 
application settings. 

-o: full path to application listing output file 

-x: proxy, can be: 
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socks4://[username@]proxy[:port] 

socks4a://[username@]proxy[:port] 

socks5://[username[:password]@]proxy[:port] 

http://[username[:password]@]proxy[:port] 
 

RDP Options 

RDP options: 

-H: client hostname. 

-T: window title for desktop connection. 

-w: override desktop width. It should be used with -h parameter. 

-h: override desktop height. It should be used with -w parameter. 

-g, -geometry {width}x{height}[{+-}{xoff}[{+-}{yoff}]]: 

standard application geometry, should be used with -m MS parameter only. 

-c: connection color depth in bits (default: 24 bits). 

-1: force seamless application placement on primary monitor only. 

-X: embed into another window with a given id, should be used with -m MS parameter only. 

-K: keep window manager key bindings. 

-e: RDP experience one or more ORed value(s) from: 

0x7F to disable everything 

0x01 to disable wallpapers 

0x02 to disable full window drag 

0x04 to disable menu animations 

0x08 to disable theming 

0x20 to disable cursor shadow 

0x40 to disable cursor blinking 

0x80 to enable font smoothing 

0x00 to disable nothing (default) 

-z: RDP compression 

0x00 to disable nothing (default) 
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0x01 to disable compression 

0x02 to limit to RDP4 compression 

0x03 to limit to RDP5 compression 

-t: maximum network timeout in seconds (default: 5 seconds) 

-l: locale identifier in HEX format (default: 0x0409 - English (United States)) 

--admin or -q: connect to administer server 
 

Device Options 

Device options: 

-P: redirect printer(s) (this flag can be repeated), can be 

"printcap" to use printers from '/etc/printcap' 

use this option if printcap was configured to contain driver name as printer comment: 

lp0|drivername:rm=clientname:rp=lp0: 

"printername" to use default printer driver 

"printername=drivername" to specify driver name  

-S: redirect sound, can be 

"off" to disable sound (default) 

"local"= quality to bring it to the client with: 

"normal" for normal quality 

"good" for good quality (default) 

"verygood" for very good quality 

"remote" to leave it on the server 

-D: redirect drive(s) (this flag can be repeated), can be 

"remotename=localpath" 

-O [option]: redirect serial ports (this flag can be repeated with option) 

"off" to disable port redirection (default) 

"auto" for COM1=/dev/ttyS0, COM2=/dev/ttyS1, LPT1=/dev/lp0 

or option to override local device path: COM1=/dev/debugtty 

-C: redirect smart card reader; pcscd smart card manager should be installed in order to use this 
feature. 
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-U [options]: redirect URI. options are comma separated list of: 

"off" disable URI redirection (default). 

"url" redirect URL (http: and https:). 

"mailto" redirect Mail (mailto:). 

Use "url,mailto" to redirect both URL and Mail. 

-k [command]: execute special command in active session, where command is one of: 

"logoff" gracefully log off a published application session. 

"disconnect" gracefully disconnect a session. 
 

Other Options 

Other options: 

-v: print version info 

--help or -?: to get help information 
 

Examples 

The following examples illustrate the use of the Parallels Client for Linux command-line interface: 

appserverclient -s<Server IP> -a<"Application Name"> -u<User Name> 

appserverclient -s192.168.0.1 -a"Internet Explorer" -uAdministrator 

In this case you are requested to logon before the application is loaded. 

appserverclient -s<Server IP> -a<"Application Name"> -u<User Name> -p<Password> 

appserverclient -s192.168.0.1 -a"Media Player" -uAdministrator –ppassword 

In this case, the logon screen is bypassed if the password is correct. 

Note: The application name is case sensitive and must be enclosed in quotes.  Examples: "Notepad", 
"Internet Explorer", "Media Player". 

Table of Available Locale Identifiers 

Identifier Name 

0x0401 Arabic (Saudi Arabia) 

0x0403 Catalan (Spain) 

0x0404 Chinese (Taiwan) 
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0x0804 Chinese (People's Republic of China) 

0x0405 Czech (Czech Republic) 

0x0406 Danish (Denmark) 

0x0407 German (Germany) 

0x0807 German (Swiss) 

0x0408 Greek (Greece) 

0x0409 English (United States) 

0x0809 English (Great Britain) 

0x0C0A Spanish - Modern Sort (Spain) 

0x0425 Estonian (Estonia) 

0x040B Finnish (Finland) 

0x040C French (France) 

0x080C French (Belgium) 

0x0C0C French (Canada) 

0x100C French (Swiss) 

0x040D Hebrew (Israel) 

0x040E Hungarian (Hungary) 

0x0410 Italian (Italy) 

0x0411 Japanese (Japan) 

0x0412 Korean (Korea) 

0x0427 Lithuanian (Latvia) 

0x0426 Latvian (Latvia) 

0x0413 Dutch (Netherlands) 

0x0813 Dutch (Belgium) 

0x0414 Norwegian (Norway) 

0x0415 Polish (Poland) 

0x0416 Portuguese (Brazil) 

0x0816 Portuguese (Portugal) 

0x0418 Romanian (Romania) 

0x0419 Russian (Russia) 

0x041A Croatian (Croatia) 

0x041B Slovak (Slovakia) 

0x041D Swedish (Sweden) 

0x041E Thai (Thailand) 

0x041F Turkish (Turkey) 

0x0424 Slovenian (Slovenia) 

0x042A Vietnamese (Vietnam) 

0x042D Basque (Spain) 

0x040F Icelandic (Iceland) 

 



 

Index 
 

A 

Adding a New Connection - 11 
Advanced Settings - 26, 36 
Authentication - 25, 35 

C 

Checking for Updates - 10 
Configuring a RAS Connection - 13 
Configuring an RDP Connection - 28 
Configuring Global Options - 37 
Configuring Parallels Client for Linux - 8 
Connection - 14, 29 

D 

Device Options - 46 
Display - 17, 31 

E 

Examples - 47 
Experience - 23, 35 
Exporting and Importing Parallels Client 

Settings - 41 

F 

Format - 42 

G 

General Options - 44 
Getting Started - 5 

I 

Installing Parallels Client for Linux - 6 

K 

KA_COUNT - 43 
KA_ENABLE - 42 
KA_INTERVAL - 43 
KA_MAXIDLE - 42 

L 

Local Resources - 20, 32 

N 

Network - 24, 35 

O 

Other Options - 47 

P 

Parallels Client Command Line Interface - 44 
Parallels Client Network Configuration File - 

41 
Parallels RAS 18 release history - 5 
Parameters - 42 
Printing - 18 
Programs - 34 

R 

RDP Options - 45 

S 

System Requirements - 5 

U 

USER_TIMEOUT - 43 
Using a RAS Connection - 39 
Using an RDP Connection - 40 
Using Parallels Client for Linux - 11 
 

Index 


	Getting Started
	Parallels RAS 18 release history
	System Requirements
	Installing Parallels Client for Linux
	Configuring Parallels Client for Linux
	Checking for Updates

	Using Parallels Client for Linux
	Adding a New Connection
	Configuring a RAS Connection
	Connection
	Display
	Printing
	Local Resources
	Experience
	Network
	Authentication
	Advanced Settings

	Configuring an RDP Connection
	Connection
	Display
	Local Resources
	Programs
	Experience
	Network
	Authentication
	Advanced Settings

	Configuring Global Options
	Using a RAS Connection
	Using an RDP Connection
	Exporting and Importing Parallels Client Settings
	Parallels Client Network Configuration File
	Format
	Parameters
	KA_ENABLE
	KA_MAXIDLE
	KA_COUNT
	KA_INTERVAL
	USER_TIMEOUT


	Parallels Client Command Line Interface
	General Options
	RDP Options
	Device Options
	Other Options
	Examples


	Index

